Restaurant Reservations Optimization Tool

Gary Thompson
Cornell University School of Hotel Administration, gmt1@cornell.edu

Follow this and additional works at: http://scholarship.sha.cornell.edu/chrtools

Part of the Food and Beverage Management Commons

Recommended Citation

This Article is brought to you for free and open access by the The Center for Hospitality Research (CHR) at The Scholarly Commons. It has been accepted for inclusion in Center for Hospitality Research Tools by an authorized administrator of The Scholarly Commons. For more information, please contact himdigital@cornell.edu.
Abstract
The purpose of this tool is to determine the best mix of tables in a restaurant, while simultaneously determining which reservations should be accepted from forecasted demand. A key parameter in the tool is the degree to which average dining durations are inflated. The tool user selects this inflation factor according to expectations regarding the extent to which parties will exceed the anticipated average dining time. Lower inflation factors result in more revenue, because more reservations are accepted, but also come with lower service levels, meaning more customers will need to wait for a table. Based on the user inputs, the tool, which uses the Solver add-in for Microsoft Excel, returns the optimum table mix for the greatest revenue.

Keywords
Cornell, restaurants, tables mix, reservations, wait times

Disciplines
Food and Beverage Management

Comments
Required Publisher Statement
© Cornell University. This report may not be reproduced or distributed without the express permission of the publisher.

This article is available at The Scholarly Commons: http://scholarship.sha.cornell.edu/chrtools/30
The purpose of this tool is to determine the best mix of tables in a restaurant, while simultaneously determining which reservations should be accepted from forecasted demand. A key parameter in the tool is the degree to which average dining durations are inflated. The tool user selects this inflation factor according to expectations regarding the extent to which parties will exceed the anticipated average dining time. Lower inflation factors result in more revenue, because more reservations are accepted, but also come with lower service levels, meaning more customers will need to wait for a table. Based on the user inputs, the tool, which uses the Solver add-in for Microsoft Excel, returns the optimum table mix for the greatest revenue.
ABOUT THE AUTHOR

Gary M. Thompson, Ph.D., is a professor of operations management in the School of Hotel Administration at Cornell University, where he teaches graduate and undergraduate courses in service operations management. Prior to joining Cornell in 1995, he spent eight years on the faculty of the David Eccles School of Business at the University of Utah. His current research focuses on restaurant revenue management, food and beverage forecasting in lodging operations, workforce staffing and scheduling decisions, wine cellars, scheduling conferences, and course scheduling in post-secondary and corporate training environments. His research has appeared in the Cornell Hospitality Quarterly, Decision Sciences, Journal of Operations Management, Journal of Service Research, Management Science, Naval Research Logistics, and Operations Research. He has consulted for several prominent hospitality companies and is the founder and president of Thoughtimus® Inc., a small software development firm focusing on scheduling products. From July 2003 through June 2006 he served as executive director of the school’s Center for Hospitality Research.
Instructions for the Restaurant Reservations Optimization Tool

by Gary A. Thompson

In a 2015 paper, I presented and evaluated ten models for restaurant reservations. In the analysis, I examined two types of models. In one type, reservations were tied to specific tables, while in the other, reservations were pooled for like-size tables. The models all optimized both the mix of tables in the restaurant simultaneously with the set of reservations open to customers. Of the ten models, seven defined the efficient tradeoff curve between revenue and customer service, and five of those seven superior models were pooled-table models. As a result, I have designed this tool to implement the simplest of the pooled-table models that I tested. In this document I describe the components of the tool, explain how to use the tool by presenting a practical example of how to use it, and present a simple example of the optimization model behind the tool. I close with some extensions to the tool.
For the purposes of our example, say that a restaurant has 3,200 square feet available for seating, including access. The restaurant tends to fill only on Friday and Saturday evenings, and the restaurant manager is trying to decide whether to reconfigure the table mix between Friday and Saturday, or go with the same mix both days. The number of seats and square footage requirements for the tables are as follows: 2 seats, 35 square feet; 4 seats, 55 square feet; 6 seats, 75 square feet; and 8 seats, 95 square feet, including access. Party values and durations by party size are given in Exhibit 1. The current forecasts of customer demand for reservations, by time period, for Fridays and Saturdays are given in Exhibits 2 and 3.
A summary of the revenue from the daily optimized table and reservations mixes

<table>
<thead>
<tr>
<th>Table Mix (#2-tops, #4-tops, #6-tops, #8-tops)</th>
<th>Revenue on Friday</th>
<th>Revenue on Saturday</th>
<th>Total Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best on Friday (9/19/13/8)</td>
<td>$7,293.84</td>
<td>$7,205.61</td>
<td>$14,499.45</td>
</tr>
<tr>
<td>Best on Saturday (16/24/10/6)</td>
<td>$7,242.08</td>
<td>$7,301.44</td>
<td>$14,543.52</td>
</tr>
<tr>
<td>Best for Average of Friday and Saturday Demand (18/20/12/6)</td>
<td>$7,270.56</td>
<td>$7,272.80</td>
<td>$14,543.36</td>
</tr>
</tbody>
</table>

Using the Tool

The tool is based on a component of Microsoft’s Excel spreadsheet called Solver. The information provided below describes the components of the tool, using a number of screen shots.

Solver’s size limitations mean that the tool is as big as it possibly can be, with 8 reservation time slots, 8 party sizes, and 4 table sizes. Given those relatively small numbers, I should note that Solver upgrades are available for a fee (from Frontline Systems), which would allow you to create bigger versions of this model.

Guide to the tool components. A screen shot of the legend is shown in Exhibit 5. The components are:

- **Inputs**—the data items you need to provide; specific inputs will be different for various restaurants, and all other items are determined by the tool;
- **Decisions**—what the tool is changing, in this case the mix of tables and the reservations accepted;
- **Objective**—The objective of the tool is to maximize revenue or contribution; and
- **Key outputs**—revenue (or contribution), estimated service level, and reservations accepted. Decision values should also be considered as key outputs.

Round-up and reservation times. A screen shot of the round-up and reservation times is shown in Exhibit 6.

- **Round-up** is a parameter the user selects that inflates the mean dining times, to give a cushion against parties that take longer than average. The larger the round-up value, the lower the revenue, but the better the level of service. Based on the value you select, you will see an estimated service level. For details on the origin of those numbers, please see my working paper, “A Simple Yet Practical Model for Optimizing Restaurant Reservations,” which I will provide on request.
- **Reservation time** is the time of the reservation. Note that you only need to specify the first time and the others will update automatically. The tool is built on the assumption that the reservation times are in 15-minute increments.
Party-specific Information

The tool assumes that the party sizes range from 1 to 8 people. The party-specific information in the tool is shown in Exhibit 7 and described below.

- **Party value** is the average value (revenue or contribution) of parties of that size.
- **Duration (in minutes)** is the average duration, in minutes, of parties of that size.
- **Duration in periods** is the number of 15-minute periods that will be allocated for the party. It is based on the duration and the round-up parameter.

- **Demand forecasts** must be provided by reservation time and party size. These are for a specific day.
- **Total** is the total number of reservations accepted for that size party.
- **Wait time limit** is used in estimating the percentage of parties that wait for a table.
- **Estimated service level** is the estimated percentage of parties that will wait longer than the specified limit for their table.
- **Total value** is the estimated value of the tool’s recommended table mix and reservations accepted.
**Table-specific Information**

Note that the tool assumes the use of 2-tops, 4-tops, 6-tops, and 8-tops only. Table-specific information is shown in Exhibit 8, as follows:

- **Number** is the number of each size table recommended by the tool.
- **Space/Table**, which is a user input, is the space required for a table with the specified number of seats. It should include an allowance for access.
- **Space used** is the total space used with the recommended table mix.
- **Space available**, another user input, is the total space available for tables, including access.
- **Tables used by period** is determined based on the reservations accepted. It is used to ensure no more tables are in use than the recommended mix allows.
- **Minimum #**, an input, is the minimum allowed number of each size table.
- **Maximum #**, an input, is the maximum allowed number of each size table.

*Note: If you want to optimize the reservations using an existing mix of tables, set the Minimum # and Maximum # for each size table to the number of tables you have of that size.*

**Solving the Tool**

Follow the steps below to solve the tool:

1. To use the tool, you will need Excel’s Solver add-in. To see whether Solver is enabled, in Excel for Windows, go to the “Data” tab and look at the right to see whether Solver is there, as shown in Exhibit 9. If you see Solver, skip to step 3, otherwise, continue with step 2.

2. To install Solver, use the File>Options>Add-Ins menu choices, then click the Go... button by Manage, Excel Add-ins, and make sure Solver is checked. Once Solver is installed, you will see it on the Data tab, as shown in the screen shot. If you have difficulty, search Help in Excel for Solver, for instructions specific to your version of Excel. Once Solver is available, continue with step 3.

3. If you are using a PC, you should be able to solve the tool by clicking the Click to Solve button, shown in Exhibit 10. If you are using a Mac, or the button does not work for you and you are using a PC, continue with step 4.
4. If you are using a Mac, or you are using a PC and the button does not work for you, you will need to run Solver manually. To do this, select the Data tab, click the Solver button, and then click the Solve button.

Note: Changing your data inputs does not automatically change the tool’s recommendations. After changing data you need to Solve it again.

Reservations Accepted, by Party Size and Table Assigned

The Reservations Accepted and Seated in Tables, which is the key output of the tool, is shown in Exhibit 11. This information shows which reservations are accepted, by time period, and at which size tables the parties will be seated. The #in# values indicate the size of the party and the size of table at which they are seated. For example, “3in4” represents a party of three seated in a 4-top, while “3in6” represents a party of three seated at a 6-top. Note that parties are not always seated in the smallest possible table. Looking at the results here, you will see that a party of one would be seated in a 4-top at 19:00.
Information by party size, for the model example

<table>
<thead>
<tr>
<th>Party Size</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Value</td>
<td>$25.80</td>
<td>$48.77</td>
<td>$69.86</td>
<td>$88.90</td>
</tr>
<tr>
<td>Average Duration (minutes)</td>
<td>42.00</td>
<td>54.00</td>
<td>59.00</td>
<td>68.00</td>
</tr>
<tr>
<td>Reservation Demand at 18:00</td>
<td>9</td>
<td>7</td>
<td>10</td>
<td>3</td>
</tr>
<tr>
<td>Reservation Demand at 18:15</td>
<td>8</td>
<td>2</td>
<td>11</td>
<td>9</td>
</tr>
<tr>
<td>Length In Periods (+0 minutes)</td>
<td>3</td>
<td>4</td>
<td>4</td>
<td>5</td>
</tr>
</tbody>
</table>

An Example of the Model behind the Tool

For people interested in the mathematics behind the tool, this section presents an example of the structure of the optimization model the tool implements. In this example, I consider only party sizes of 1 to 4 people, table sizes of 2 and 4 seats, and two reservation times. Details on the parties are given in Exhibit 12. Further, I assume that the restaurant has 1,800 square feet available for tables (and access) and that the 2-tops require 35 square feet and 4-tops, 55 square feet (including access space).

I use as variables \( n_i \), representing the number of tables with \( i \) seats; and \( g_{cp} \), representing the number of reservations accepted for parties of size \( c \), at period \( p \), placed in a table with \( i \) seats. The objective, which is to maximize total value, is:

\[
\text{Max } \$25.80 * (g_{1,1,2} + g_{1,1,4}) + \$48.77 * (g_{2,1,2} + g_{2,1,4}) + \$69.86 * (g_{3,1,4}) + \$88.90 * (g_{4,1,4} + g_{4,2,4})
\]

In words, the first part of the objective comes from the $25.80 revenue from each party of one person and from reservations for a party of 1 possibly being taken for a 2-top or a 4-top for each of the two periods. The other parts of the objective represent the values of parties of 2, 3, or 4, times the number of appropriate reservations, with the practical limitation that parties of 3 and 4 can only be seated in 4-tops.

The first constraint imposes the limit of the size of the restaurant:

\[35 * n_2 + 55 * n_4 \leq 1,800\]

In words, the left size of the constraint calculates the total space used by the 2-tops and adds it to the total space used by the 4-tops, against the limitation of the restaurant’s size, on the right.

The next set of constraints ensures that the number of tables in use in each period, of each size, cannot exceed the number of that size table:

- [period 1, 2-tops] \( g_{1,1,2} + g_{2,1,2} \leq n_2 \)
- [period 1, 4-tops] \( g_{1,1,4} + g_{2,1,4} + g_{3,1,4} + g_{4,1,4} \leq n_4 \)
- [period 2, 2-tops] \( g_{1,1,2} + g_{2,1,2} + g_{2,2,2} \leq n_2 \)
- [period 2, 4-tops] \( g_{1,1,4} + g_{1,2,4} + g_{2,2,4} + g_{3,1,4} + g_{3,2,4} + g_{4,1,4} + g_{4,2,4} \leq n_4 \)

As an example, in the first constraint of this set (period 1, 2-tops), reservations of both parties of 1 and 2 are summed; in the second constraint (period one, 4-tops), reservations of all party sizes are summed. Note that for period two (constraints three and four), reservations that were accepted in period one must still be considered when counting the tables in use. In this simple example, which has only two reservation periods, no reservations disappear from the constraints, given that the shortest dining duration exceeds two periods. If our example had four periods then table usage in period four would not be affected by reservations for parties of 1 taken in period one, since those parties would have departed before period four.

The next set of constraints impose the demand limits, by party size and reservation period:

- [party size 1, period 1] \( g_{1,1,2} + g_{1,1,4} \leq 9 \)
- [party size 1, period 2] \( g_{2,1,2} + g_{2,2,2} \leq 8 \)
- [party size 2, period 1] \( g_{1,1,2} + g_{2,2,2} \leq 7 \)
- [party size 2, period 2] \( g_{2,2,2} + g_{2,2,4} + g_{3,1,4} \leq 2 \)
- [party size 3, period 1] \( g_{3,1,4} \leq 10 \)
- [party size 3, period 2] \( g_{2,2,4} \leq 11 \)
- [party size 4, period 1] \( g_{4,1,4} \leq 3 \)
- [party size 4, period 1] \( g_{4,2,4} \leq 9 \)
As an example, the first constraint in the set ensures that the number of reservations for parties of one, taken in period 1, and placed in 2-tops or 4-tops, does not exceed the demand of nine parties.

The number of tables must be integers and, given the 1,800 square feet in the restaurant, there can be at most 57 two-tops or 36 four-tops, limitations which are imposed as:

\[
\begin{align*}
\text{[2-tops]} & \quad n_2 = 0, 1, \ldots, 57 \\
\text{[4-tops]} & \quad n_4 = 0, 1, \ldots, 36
\end{align*}
\]

The final set of constraints, which are implicitly or explicitly defined in the demand constraints, are the integer requirements and limits on the reservations accepted by party size, arrival period, and table size:

\[
\begin{align*}
\text{[party size 1, period 1, 2-top]} & \quad g_{1,1,2} = 0, 1, \ldots, 9 \\
\text{[party size 1, period 1, 4-top]} & \quad g_{1,1,4} = 0, 1, \ldots, 9 \\
\text{[party size 1, period 2, 2-top]} & \quad g_{1,2,2} = 0, 1, \ldots, 8 \\
\text{[party size 1, period 2, 4-top]} & \quad g_{1,2,4} = 0, 1, \ldots, 8 \\
\text{[party size 2, period 1, 2-top]} & \quad g_{2,1,2} = 0, 1, \ldots, 7 \\
\text{[party size 2, period 1, 4-top]} & \quad g_{2,1,4} = 0, 1, \ldots, 7 \\
\text{[party size 2, period 2, 2-top]} & \quad g_{2,2,2} = 0, 1, \ldots, 2 \\
\text{[party size 2, period 2, 4-top]} & \quad g_{2,2,4} = 0, 1, \ldots, 2 \\
\text{[party size 3, period 1, 4-top]} & \quad g_{3,1,4} = 0, 1, \ldots, 10 \\
\text{[party size 3, period 2, 4-top]} & \quad g_{3,2,4} = 0, 1, \ldots, 11 \\
\text{[party size 4, period 1, 4-top]} & \quad g_{4,1,4} = 0, 1, \ldots, 3 \\
\text{[party size 4, period 2, 4-top]} & \quad g_{4,2,4} = 0, 1, \ldots, 9
\end{align*}
\]

The optimal solution to this problem, which can be found using the tool, yields an estimated daily revenue of $2,553.63. The restaurant would use 9 two-tops and 27 four-tops. The reservations accepted are given in Exhibit 13.

Extensions

While I have presented as complex a model as can be solved in the standard version of Solver, there are a variety of possible enhancements, if one is willing to deal with increased complexity. For example, in a 2015 article, I evaluated models that matched parties to specific tables, rather than the pooled-table approach used here. I further offered a more sophisticated (and complex) approach to representing the variation in dining duration compared to just inflating the dining time, which worked well for the pooled-table models. Moreover, this tool assumes that demand timing is fixed, whereas in reality, restaurant customers often have the flexibility to arrive at a variety of dining times. Incorporating demand timing flexibility is expected to increase profitability, at the expense of a more complex, harder-to-solve model.

---

# 2015 Reports

### Vol. 15 No. 21 Hotel Brand Conversions: What Works and What Doesn’t, by Chekitan S. Dev, Ph.D.

### Vol. 15 No. 20 The United States Supreme Court Rules in Favor of Employees in the Young and Abercrombie Cases: What Do They Really Hold?, by David Sherwyn, J.D., and David B. Ritter

### Vol. 15 No. 19 The New Science of Service Innovation, Part 4: Select Research on People from the 2014 Cornell Hospitality Research Summit, by Cathy Enz, Ph.D., and Rohit Verma, Ph.D.

### Vol. 15 No. 18 The New Science of Service Innovation, Part 3: Select Research on Technology from the 2014 Cornell Hospitality Research Summit, by Cathy Enz, Ph.D., and Rohit Verma, Ph.D.

### Vol. 15 No. 17 The New Science of Service Innovation, Part 2: Select Research on Organizations from the 2014 Cornell Hospitality Research Summit, by Cathy Enz, Ph.D., and Rohit Verma, Ph.D.

### Vol. 15 No. 16 The New Science of Service Innovation, Part 1: Select Research on Data from the 2014 Cornell Hospitality Research Summit, by Cathy Enz, Ph.D., and Rohit Verma, Ph.D.

### Vol. 15 No. 15 Adopting the Code: Human Trafficking and the Hospitality Industry, by Michele Sarkisian

### Vol. 15 No. 14 How the Deepwater Horizon Oil Spill Damaged the Environment, the Travel Industry, and Corporate Reputations, by Alex Suskind, Ph.D., Mark Bonn, Ph.D., and Benjamin Lawrence, Ph.D.

### Vol. 15 No. 13 Creative Capital: Financing Hotels via EB-5, by Arian Mahmoodi and Jan A. deRoos, Ph.D.

### Vol. 15 No. 12 Hospitality HR and Big Data: Highlights from the 2015 Roundtable, by J. Bruce Tracey, Ph.D.

### Vol. 15 No. 11 Cuba’s Future Hospitality and Tourism Business: Opportunities and Obstacles, by John H. Thomas, Ph.D., Miranda Kitterlin-Lynch, Ph.D., and Daymaris Lorenzo Del Valle

### Vol. 15 No. 10 Utility and Disruption: Technology for Entrepreneurs in Hospitality; Highlights of the 2015 Technology Entrepreneurship Roundtable, by Mona Anita K. Olsen, Ph.D., and Kelly McDarby


### Vol. 15 No. 8 A Competency Model for Club Leaders, by Kate Walsh, Ph.D., and Jason P. Koenigsfeld, Ph.D.

### Vol. 15 No. 7 From Concept to Impact: Beginning with the End in Mind; Highlights of the 2015 Cornell Hospitality Entrepreneurship Roundtable, by Mona Anita K. Olsen, Ph.D., Kelly McDarby, and Joanne Jihwan Park

### Vol. 15 No. 6 The Mobile Revolution Is Here: Are You Ready?, by Heather Linton and Robert J. Kwornik, Ph.D.

### Vol. 15 No. 5 What’s Next in Loyalty Programs: Highlights of the 2014 Cornell Loyalty Program Management Roundtable, by Michael McCall, Ph.D.

### Vol. 15 No. 4 Looking Under the Hood: The Catalysts of Hotel Credit Spreads, by Jan A. deRoos, Ph.D., Crocker H. Liu, Ph.D., and Andrey D. Ukhov, Ph.D.

### Vol. 15 No. 3 Environmental Sustainability in the Hospitality Industry: Best Practices, Guest Participation, and Customer Satisfaction, by Alexandra Bruns-Smith, Vanessa Choy, Howard Chong, Ph.D., and Rohit Verma, Ph.D.

### Vol. 15 No. 2 Competitive Hotel Pricing in Europe: An Exploration of Strategic Positioning, by Cathy Enz, Ph.D., Linda Canina, Ph.D., and Jean-Pierre van der Rest, Ph.D.

### Vol. 15 No. 1 2015 Compendium

# 2015 Tools

### Vol. 6 No. 3 Instructions for the Wine Cellar Management Tool, Version 3, by Gary Thompson, Ph.D.

### Vol. 6 No. 2 A Location-Planning Decision-Support Tool for Tradeshows and Conventions, by HyunJeong (Spring) Han, Ph.D., and Rohit Verma, Ph.D.

### Vol. 6 No. 1 How to Feel Confident for a Presentation...and Overcome Speech Anxiety, by Amy Newman

# 2014 Reports

### Vol. 14 No. 24 What Message Does Your Conduct Send? Building Integrity to Boost Your Leadership Effectiveness, by Tony Simons, Ph.D.

### Vol. 14 No. 23 More than Just a Game: The Effect of Core and Supplementary Services on Customer Loyalty, by Matthew C. Walsman, Michael Dixon, Ph.D., Rob Rush, and Rohit Verma, Ph.D.
Advisory Board

Syed Mansoor Ahmad, Vice President, Global Business Syed Mansoor Ahmad, Vice President, Global Business Head for Energy Management Services, Wipro EcoEnergy

Marco Benvenuti '05, Cofounder, Chief Analytics and Product Officer, Duetto

Scott Berman ’84, Principal, Real Estate Business Advisory Services, Industry Leader, Hospitality & Leisure, PwC

Erik Browning ’96, Vice President of Business Consulting, The Rainmaker Group

Bhanu Chopra, Chief Executive Officer, RateGain

Benjamin J. “Patrick” Denihan, Chief Executive Officer, Denihan Hospitality Group

Chuck Floyd, Chief Operating Officer-North America, Hyatt

R.J. Friedlander, Founder and CEO, ReviewPro

Gregg Gilman ’85, Partner, Co-Chair, Employment Practices, Davis & Gilbert LLP

Susan Helstab, EVP Corporate Marketing, Four Seasons Hotels and Resorts

Steve Hood, Senior Vice President of Research, STR

Gene Hopper, Strategy & Alignment, Monscierge

Sanjeev Khanna, Vice President, Tata Consultancy Services

Gerald Lawless, Executive Chairman, Jumeirah Group

Josh Lesnick ’87, Chief Marketing Officer, Wyndham Hotel Group

Mitrankur Majumdar, Associate Vice President, Regional Head—Services Americas, Infosys Limited

Bharet Malhotra, Senior VP, Sales, CVENT

Faith Marshall, Director, Business Development, NTT Data

Kelly A. McGuire, MMH ’01, PhD ’07, VP of Advanced Analytics R&D, SAS Institute

David Mei, Vice President, Owner and Franchise Services, InterContinental Hotels Group

David Meltzer MMH ’96, Chief Commercial Officer, Sabre Hospitality Solutions

Mary Murphy-Hoye, Senior Principal Engineer (Intel's Intelligent Systems Group), Solution Architect (Retail Solutions Division), Intel Corporation

Brian Payea, Head of Industry Relations, TripAdvisor

Cornell Hospitality Tool
Vol. 6, No. 4 (November 2015)
© 2015 Cornell University. This report may not be reproduced or distributed without the express permission of the publisher.

Cornell Hospitality Report is produced for the benefit of the hospitality industry by The Center for Hospitality Research at Cornell University.

Michael C. Sturman, Academic Director
Carol Zhe, Program Manager
Glenn Withiam, Executive Editor
Alfonso Gonzalez, Executive Director of Marketing and Communications

Center for Hospitality Research
Cornell University
School of Hotel Administration
537 Statler Hall
Ithaca, NY 14853
607-255-9780
chr.cornell.edu

Umar Riaz, Managing Director—Hospitality, North American Lead, Accenture

Carolyn D. Richmond ‘91, Partner, Hospitality Practice, Fox Rothschild LLP

David Roberts ’87, MS ’88, Senior Vice President, Consumer Insight and Revenue Strategy, Marriott International, Inc.

Rakesh Sarna, Managing Director and CEO, Indian Hotels Company Ltd.

Larry Sternberg, President, Talent Plus, Inc.

Berry van Weelden, MMH ’08, Director, Reporting and Analysis, priceline.com's hotel group

Adam Weissenberg ’85, Vice Chairman, US Travel, Hospitality, and Leisure Leader, Deloitte & Touche USA LLP

Rick Werber ’82, Senior Vice President, Engineering and Sustainability, Development, Design, and Construction, Host Hotels & Resorts, Inc.

Dexter E. Wood, Senior Vice President, Global Head—Business and Investment Analysis, Hilton Worldwide

Jon Wright, President and Chief Executive Officer, Access Point